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Introduction

Murasu Anjal is a suite of software tools that help create, edit, convert and publish Tamil
content on Windows and Mac OS X operating environments.

Muthu Nedumaran first developed the software in 1985, on a personal computer
running MS DOS 3.1 operating system as a hobby. The early versions of the software
had both software and hardware components. The graphics card hardware was
modified to render Tamil characters along with Roman letters.

Features of the software were regularly updated year after year. Murasu Anjal 5.0, the
first version to run on Microsoft Windows operating environment (Windows 3.0) was
released in 1991. Mac OS X version of Murasu Anjal was included as part of the
operating system in Tiger (10.4).

Murasu Anjal changed the Tamil publishing landscape in the region from the day it was
first introduced. Daily, weekly and monthly publications and printed books were
produced with Murasu Anjal.

Version 9 of the software, which was introduced in late 1999 included support for
Unicode. It is widely believed that Murasu Anjal was the first Tamil input software to
support Unicode at that time. Much of the technical design of the software remained the
same from versions 5.0 till 9.7. Modern operating systems such as Windows 7 and Mac
0S X provide much better support for Indian languages. As such the old design required
areview.

Murasu Anjal 10, introduces a completely redesigned set of components. Each of the
components takes advantage of the operating system services to bring out the best
utilities for Tamil while staying conformant to the standards for better co-existence with
other languages, specifically Chinese.

This release includes companion tools that will help users create Tamil content with
improved ease of use and compatibility with all the common software, specifically Office
and Web applications.

A highly sophisticated input method editor, look-up word dictionary, visual keyboard
are just to name a few. Legacy documents composed with older encoding formats like
TSCII, TAB, TAM and Murasu-6 can be converted to Unicode with Anjal's embedded
conversion tools. High quality Tamil Unicode fonts, some with regular and bold
variants are included for better presentation

The “Nigandu” feature introduced in Anjal 9.5 has been redesigned in the new version. It
now includes a complete Tamil-English dictionary from Lifco.
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Overview of Key Features

Input Methods

Unlike previous versions of Murasu Anjal that provided keyboard drivers, Murasu Anjal 10
provides Input Methods based on Text Services Framework. This ensures compatibility with all
Unicode supported applications and future versions of Windows and Mac OS X.

Visual Keyboard and Character Palette

To assist new users who want to learn the Tamil99 keyboard layout, the Tamil99 Visual
keyboard is provided so that users can click through the keys to input text or use it as an on-
screen reference while typing on the physical keyboard. The Character Palette allows users to
select Tamil symbols and numerals that are not mapped to the keyboard layout.

Lookup Word with Lifco Tamil-English Dictionary

The complete Tamil-English Dictionary is bundled into Anjal. This will allow users to lookup the
words and check their meanings, as they are composed.

Anjal Unicode Fonts

Fifteen professionally designed Tamil Unicode fonts are included. Some of them are provided
with regular and bold variants for better contrast between body text and headings. In addition,
Anjal InaiMathi Schoolbook font is specifically adapted to comply with the written form of Tamil
alphabets as approved by MOE.

Document converter Add-In for MS Office

Old documents created in legacy encoding such as TSCII, TAB or TAM can be converted to
Unicode with the converter embedded into Office applications. For the first time, users will be
able to convert even PowerPoint and Excel documents. This add-in is available only in the
Microsoft Windows version.

File Converter for HTML and Text Documents

Legacy documents in TXT or HTML files can be converted using the file converter. Users just
drag-and-drop these files and the converter creates Unicode versions of the files. Many files can
be selected and dropped into the converter for a batch conversion.

Anjal PDF Writer

PDF is vital for exchanging documents with others while retaining the formatting information.
For this reason, Anjal includes a PDF writer, which is installed as a virtual printer. PDF files can
be created from any application by just printing to Anjal PDF Writer.

Anjal.Net Community Portal

This online portal is created for users to exchange views, participate in forums, create blogs and
read regularly posted articles and guides on Murasu Anjal software. Membership is open to all
Anjal users.
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Installation

Pre-requisites
Before installing Anjal into your computer, please ensure that you have the following
minimum requirements:

1. An active Internet Connection
a. Internet connection is required at the time of installation. This is to
verify your Anjal 10 serial number.

2. Adobe Reader or any PDF reader
a. This is required to read the help document and other PDF documents
that you may create from time to time.
If you are able to read this help document, then your computer already
has a reader installed.

3. Microsoft Windows Xp with Dot Net Framework 2.0
a. Ifyour computer is running Windows Vista or later, the required Dot Net
framework is already included.
b. For WindowsXp, you may install the framework from the distribution
CD-ROM. The link to install this can be found in the main screen of the
installation CD-ROM.

4. Complex Script Support enabled & Text Services turned on (Windows Xp only)

a. If you are running Windows Vista or Windows-7, you need not do
anything to enable this.

b. For WindowsXp, you may enable Complex Script by opening “Regional
and Language Options” in control panel and checking this option (shown
below)

c. Click on the “Details” button, select the “Advanced” tab and check
“Extend support of advanced text services to all programs”.

Regional and Language Options E] Text Services and Input Languages @g]
Regional Options = Languages | Advanced Settings | Advanced
Text ‘sc-wiceg and input languages Compatibility Configuration
To view or change the languages and methods you can use to enter i
text, click Details. Extend support of advanced text services to all programs
Select this check box to tum on advanced text services in Notepad and
other programs that do not normally support speech and handwriting
recognition or other advanced input services.
Supplemental language support
Most languages are installed by default. To install additional languages, System Configuration
select the appropriate check box below. [ Tum off advanced text services
Install files for complex script and right-to-left languages (including Select this check box to tum off advanced text services in all programs.
Thai) Not recommended for East Asian users because this closes the
= " I bar.
[] Install files for East Asian languages anguage bar.

Note: You may be required to insert the WindowsXp CD-ROM when you
click “Apply” or “OK” in the “Regional and Language Options” window.
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Installing Murasu Anjal
Start the Murasu Anjal installer either by double clicking the downloaded file or from
the appropriate link on the CD-ROM main screen.

Follow the steps as outlined below to complete the installation:

i Murasu Anjal 10 Release Candidate 5 Setup @ i Murasu Anjal 10 Release Candidate 5 Setup @
Customer Information

Welcome to the Murasu Anjal Please enter your customer information ( 7,

b 10 Release Candidate 5 Setup

. Wizard

. User Name:
The Setup Wizard will install Murasu Anjal 10 Release |R aja Chozan

1. Candidate S on your computer. Click "Next" to continue or

Email Address:

F‘L "“Cancel" to exit the Setup Wizard.
|raja.chozan@murasu.com

N Serial Number:
ﬂ \
e

Advanced Installer

e e

IMPORTANT: It is important to enter your full name and email address in the respective
columns. In addition, Murasu Anjal requires a Serial Number for activation. Depending
on your type of purchase, this number can be found either in your purchase receipt
email or pasted on the CD-ROM cover. Make sure you enter the Serial Number exactly as
provided.

15 Murasu Anjal 10 Release Candidate 5 Setup 1% Murasu Anjal 10 Release Candidate 5 Setup @
Select Installation Folder Ready to Install
This is the folder where Murasu Anjal 10 Release Candidate S will be installed. ( /, The Setup Wizard is ready to begin the Murasu Anjal 10 Release Candidate... ( 7,
To install in this folder, click "Next". To install to a different folder, enter it below or click Click "Install" to begin the installation. IF you want to review or change any of your
"Browse", installation settings, click "Back". Click "Cancel" to exit the wizard.
Eolder:

|citprogram Files\Grow Momentumiurasu Anjal 10 Release Candidal Browse...

Advanced Installer Advanced Installer

<Back | Next> | [ Cancel <Back | _mnstal | [ Cancel

Click the Next button to accept the default values. It is highly recommended that you
keep the installation Folder as provided.

15 Murasu Anjal 10 Release Candidate 5 Setup 3]

Completing the Murasu Anjal
b 10 Release Candidate 5 Setup
Wizard

Click the "Finish" button to exit the Setup Wizard.

Click Finish once the installation is complete. This will close the installer. There is no
further configuration or setup to do on Murasu Anjal, except to install the Anjal PDF
writer. We'll do that next.
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Installing Anjal PDF Writer
If you are installing from the CD-ROM, click on the link in the main screen.

(Anjal PDF Writer can also be downloaded from Anjal.Net. However, you must login before
you can download. You may create a login ID if you do not have one. See the Anjal.Net
section later in this document. Once you have logged in, navigate to the Anjal PDF writer
page to download and install the software).

The installation of Anjal PDF writer is very simple. Click OK when prompted for
Destination Folder to accept the default.

Choose Destination Location

Destination Folder

C:\Program Files\Murasu SystemsitMurasu Anjal Browse...

oK I Cancel

Once the installation is complete, you will get the confirmation and a brief user guide on
how to create PDF documents:

Murasu Anjal PDF Setup

Setup has finished installing Murasu Anjal PDF on your computer, Please restart your system.

To create PDF document, just print o the Murasu Anjal PDF printer from any Windows application.

A Print to the PDF Writer Driver - Microsoft Internet Explorer Q@@
File Edit View Favorites Tools Help ,','
Qe - () [¥] [&] (D Dseach 57 Favortes €2 WA= S

Address | €] C:\Program FilesiMurasu SystemsiMurasu AnjalREADME,HTM v Go | Links >

~
To create PDF files:

To use your PDF Writer, open the file that you would like to print to PDF. Select
the Print option {usually found under File = Print), and select "PDF Writer" from
the list of available printers. You will be prompted to select the destination
directory and filename for your output file.

Please note that some applications, such as NotePad, will automatically print to
your default printer when you select the Print option. If you want to print to PDF
Writer, you may need to change your printer selection within that application
befare printing the file. This can typically be done from Page Setup.

To install PDF Writer:

1. Double-click the Setup.exe file in Windows Explorer.
2. Follow all the instructions in the dialog boxes that appear.

1. Onthe Windows taskbar, click Start.

2. Click Run.

3. Inthe Open boy, type the full path of the Setup.exe file.

4. Click OK.

* If your OS is Windows 2000/XP, please use an administrator account to install

the application.
** PDF Writer supports Microsoft Windows 98/ME/2000/XP/ista.

&) Done - My Computer
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Tamil Input Methods

The Language Bar

The installer would have added Anjal input methods to the language bar in Windows.
You can invoke the input method in the following ways:

1. Click on the “EN” button on the right hand corner of the task bar.

Tarmil

v @ English {(United States)

‘ Show the Language bar

EN Qz‘_ﬁ.o % 11:17 PM EN Q;‘Ro % 11:17 PM

The languages menu will pop-up. Select “TA” to set the input to Tamil mode.

2. Permanently display the language bar on the desktop.
a. Instead of clicking on the “EN” or “TA” button on the task bar all the time,
you can make the language bar float on the desktop.
b. To do this, click on the “EN” or “TA” button (as shown above)
c. Select “Show the Language bar” menu item.
d. Once the language bar is on the desktop, you can then use that to switch
input languages.

g ed ate ?

Tamil

v @ English {United States)

e. When you select Tamil, you will see the Anjal icon and the Anjal Options
menu.

TA Tamil € Murasu Anjal < Options Bl 7

Selecting the Input Language

The language bar allows you to select Input Languages. You can have multiple input
languages in Windows. These languages can be Chinese, Arabic or others. Selecting the
input language activates the input method (or keyboard layout) associated with the
language.

In the case of Anjal, you must select Tamil as the input language. This is shown in figure-
2(d) above.

Anjal also includes an “Options” menu in which you can choose your keyboard layout,
start the Visual Keyboard, the Character Palette or switch input modes.

TA Tamil ¢ Murasu Anjal 4 Options Hl 7

Visual Keyboard

Character Palette

v Tamil Mode [F12]

About Murasu Anjal
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Selecting the Input Method

Murasu Anjal includes 8 input methods. They are listed in the Options menu shown
below. The default input method will be Anjal. You can change that to your preferred
one by simply selecting it from the menu. The active input method will have a tick mark
on the item.

Input Method b v zagse [Anjal]
HH-99 [Tamil-99]

Visual Keyboard
Character Palette SU0p-99 [MOE-Singapore]
(-6 [Murasu-6]

v Tamil Mode [F12]
wprw-7 [Murasu-7]

About Murasu Anjal Lemp 5L Es [01d TW]

L SULES [New TW]
wufiene [Mylai]

Switching Input Modes [English <-> Tamil]

While Murasu Anjal remaps the keyboard for Tamil text input, it also allows users you to
change the input-mode to English. In other words, with Murasu Anjal, you can input in
Tamil and English while remaining in Tamil mode.

To do this, use the F12 key. Users of earlier versions of Murasu Anjal will be familiar
with this.

Note that F12 allows you to change “input mode” between Tamil and English without
changing the “input language”.

Note: Once you change the input language (by selecting a different language in the
language bar), F12 will no longer function as the mode-switching key.
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Anjal Input Method

Murasu The Murasu Anjal keyboard layout was introduced in the first version of Murasu
Anjal released in early 1994. It is based on the phonetic mapping of Tamil letters to
those of English. The table below shows the mapping:

2 WIT TWSGISH6T OloW 6TWPSSHIS6T
(Vowels) Consonants)

S a & k
e A or aa & ch or s
o) i L d or t
T I or ii 5 th
El u N p or b
en U or uu ) R
6T e
6] E or ee L y
3 ai ) r
6 o 60 1
) O or oo 6l \4
60617 au I:p Z
&o q 61 L
&hS T(WSGS6T - Grantha
Ny h Tl ng
610 S €b nj
Fng X 6007 N
& j i n- or w
64 sh LD m
uh sri 60 n or n=

Anjal Key sequences:

1. To get compound letters (2_udjGliour), type the base consonant followed by the
respective vowel. Examples:

mozi => Glomy
anbu => oy

2. To get elongated vowels (@piyev) type the same vowel twice or upper case
letter. Examples:

yaakaavaaraayinum => u.IITd':BITG).IITIIITuﬁ]@lLb

yAKAVArAyinum => WISTTTTUIeID
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3. Words with eorp. Type ndr to get eorp. Examples:
mandram => LOGTMLD
kandru => &6
toondri => Ggme

4. Words with pm. Type tr to get mm. Examples:
patru => LD
pootri => Glurpn
petraal => GlupMTEL

5. Words with ewr_. Type nd to get swor_. Examples:
mandapam => LDGOTL_LILD
kandu => &eor(h
veendaam => @eueorL_mD

6. Words with 55. Type ntto get Bg. Examples:
sontam => QFMHGD
anti => 9B
vantu => Qb

7. Words with ¢p&. Type njj to get ¢he. Examples:
ManjjaL => LOEh&6N
Tanjjam => FEHFLD
Konjji => Q&mehd

8. Words beginning with the letter 5. When n is typed after a space, tab or
Return key, it will automatically produce ‘’.
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The Tamil99 Layout
The key arrangements in Tamil99 is shown in the figure below:
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1. The vowels are arranged on the left and consonants on the right.

2. Some punctuation keys are reassigned: example single-quote, double-quote,
semi-colon, colon, forward-slash and square brackets. You may also type these
characters from their original location while in “English mode”.

3. The Grantha letters are mapped to upper case letters Q, W, E, R, T and Y.
Therefore, you need to press the shift key to input Grantha letters.

4. Independent vowels (9 to %) are typed by pressing the respective keys in the
layout. These keys will become dependant vowels (o955 @Mui®) when typed
immediately after a base consonant.

5. To get base consonants, type the respective keys on the right.

6. To get compound letters (2_udjGiour), type the base consonant followed by the

respective vowel.
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Tamil99 Pulli ( *)
Pulli is mapped to the lower case ‘ f’ key. Since a pulli can only follow a base consonant,
this key will generate AYTHAM (o%) when typed without a preceding base consonant.

Tamil99 Composition Examples
Below are some examples of simple Tamil words and their respective keystroke
sequence:

< () (B (B (B () (M (e
s | (Vo ) [Ta) T (Fe) (o) (7

S0 HEE S
o | | J(°2) (Y0
PR Fon T T R TERTES

sosepd | (L) (s) €] Ca) ) L) CIEEEE)
v | (10 (o )LL) S
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Visual Keyboard and Character Palette

To assist users who are new to the Tamil text input or the Tamil99 keyboard layout,
Anjal provides a Visual Keyboard tool. The Visual Keyboard is a tool-window that will
be always on top of all other application windows. (NOTE: Anjal Input method explained
above does not need a Visual keyboard as the mapping is based on regular English
keyboard)

Likewise, a Character Palette tool is provided to input Tamil symbols and numbers that
are not mapped to the keyboard layout.

To start the Visual Keyboard or the Character Palette, select the respective menu item
from Anjal language bar options menu:

TA Tamil ¢ Murasu Anjal 4 Options -

Visual Keyboard

Character Palette

v Tamil Mode [F12]

About Murasu Anjal

Options menu showing Visual Keyboard and Character Palette menu items

ang
P —
L elo e[ s[elv o] o]o] | -ow] | <] €[] u]o]ar[=
o fafw[m[afofa|o[a| o] o] || [B]s]|e|e]|=]|¥ e
(ows|a|@fefs|a]|efufufs|pjujem| foO]|®«[r]-]|s]z]
e DLLTELILLEL= ) [T [

Switch to EN

Visual Keyboard and Character Palette showing the target application as Wordpad

Setting the target application

1. After starting the Visual Keyboard or Character Palette, simply click on the
application window you want to send the ‘keystrokes’ or characters to.

2. The name of the selected target application will be shown on the palette’s
window title.

3. Once the target application has been set, click on the respective buttons on
either palette to send the characters.

4. To change to another target window, simply click on the new window’s input
area.

Note on Tablet PCs: The behavior may not be the same on Tablet PCs. It may not be
possible to change the target window on Tablet PCs. To do so, you may need to quit the
Visual Keyboard or Character Palette and restart it when the new target window is active.
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Using the Visual Keyboard

Once your target application is set, you can click on the keys to send keystrokes to the
application. This action is similar to typing the corresponding keys on the keyboard.

You can switch the mode from Tamil to English by clicking on the “Switch to EN” key at

the bottom of the keyboard. The picture below shows the Visual Keyboard in English
mode.

Tamil99 (MOE): [Microsoft \

LT T e L o o] ] - o
OoOOnnEOnEnonn
e e o ] o]
= LLLTTTTLLL L=

To simulate a “Shift”, click on the “Shift” key. This will hold the shift key until the next
key is clicked. Once the next key is clicked, the “Shift” key will be “released”.

To hold the “Shift” key permanently, click the “Caps” key. This will ensure that the Visual
Keyboard is always in the shifted state.

Observe that the key labels change when the “Shift” of “Caps” key is clicked. The picture
below shows the Visual Keyboard with “Shift” key clicked. Note that the Granta letters
are mapped to the respective keys in the Tamil99 layout.

Tamil99 (MOE): [Microsoft \

el el el Te ] owe
| fajafmjaje) | |jrffrfr]
oo ) J | e J Jefe] ] ] e
JJJJJJJ‘JJJ
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Characters in the Character Palette

The character palette utility allows you to input characters that are not mapped to the
Tamil99 keyboard. In addition it also includes non-Tamil characters that are not
available in the standard PC keyboard.

The picture below shows the classification of Tamil numerals and symbols defined in
the Unicode standard.

lo|as|l2|r|e|@®

TLEEEEE

a| S| ulew Gl M

@| S| ¢|£| | ¥|E€

©| ®| «| »| *| g| 2

B R N R (77 7Y (A
Yellow box: Tamil Sign OM
Red Box: Tamil Numerals
Blue Box: Various Tamil Signs
Purple Box: Tamil Rupee Sign

Note: The Unicode name of the characters will appear at the bottom of the palette when
the mouse is placed above the character.
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Lookup Word with LIFCO Tamil Dictionary

Murasu Anjal 10 includes the complete Tamil-English Dictionary from LIFCO. Details of
the print version of this dictionary can be found at http://lifcobooks.com

The dictionary can be used while composing Tamil text to lookup Tamil words and their
meanings in Tamil and English.

Lookup word will only work on MS Word documents in Windows Xp. On Windows Vista,
it works on MS Word, PowerPoint and Excel. It can be invoked as follows:

Lookup active word
Active word is the word that is currently being composed.

To lookup an active word, just press the “Esc” key immediately after typing the last
letter in the word. The Esc should be typed before any space or punctuation mark is
typed.

The figure below shows the lookup word window showing the entries for the active
word.

LDEmEY

>

LO60YED
(1) UjEUSLD mountain; (2) ASTGH collection; (3) GuUTHH
Q&mTLAED occupation of fighting.

LOEGISD

(1) SENHHIASTET wear; (2) CLOMASTEN take upon oneself;
(3) @58 resemble; (4) UMESHEL QFIW pluck; (5)
a&isa0 Gurfl(y fight against; (6) WM be confused;
(7) unan(® dispute; (6U.Q&M.) LDENEIGED.

LOGGIEY
(1) Gumy Q&I fight; (2) LMTMILE become unfriendly; (3) —
LOWMRIE be confused; (4) HenSUUMI be amazed; (5)
UM distress; (6U.QFT.) LONEVESED.

GLosyLh

LOENELESTTE): LOENEVESSILD: LOFVE GIJLD: LOEHEDGED:
LOENELILIMLDLY: LOGNEULIL]: LOFNEULOGET: LOGNEILOENEILLITS:

m

Note: You may click on the words in the grey box at the bottom to lookup more words.
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] Documentl - Microsoft Word TATamil (india) ¢ MurasuAnjal @ Options (2) o |[E][=
File Edit View Inset Format Tools Table Window Help T tion f > X
NEHROS T E B S [9-Co|@ F|8% - @) Al converter i - B
[x] 3-I'2-I'1-I~§'v‘1-|rzvllzrvd-lrs-lrsvv‘7'I'8'l'9'l'ID'v‘n'l'IZ'I'13'|'14'US-I-16-I~17-|' —
~

-z LDENEY

- weme i

~ (1) UheusLD in; (2) ABTGH collection; (3) BUTHS

- Q@QMLA6d occupation of fighting.

o Loeney . X X £

T (1) SiTNHSIE wear; (2) GLOMASTET take upon oneself; |-

- (3) ®58® resemble; (4) UMESEL QS pluck; (5)

- aHi55I0 GUIAE fight against; (6) LWRIG be confused;

M (7) umsM(® dispute; (6U.GI&M.) LDENEZED.

- Lo6nEy .

M (1) Gury @& fight; (2) LTMILE become unfriendly; (3)

- WWRIG be confused; (4) HOSUILUDI be amazed; (5)

I QUGSS distress; (61.0ET.) LOMEVSE60.

- Clogn

® LOENELESTTED; LDENEVEABILD; LOENELE &IJLD; LOEDEVGED;

z LOENEULILIMLDLY; mﬂf}suﬂw u)sznsum.s,s'n- LOEDELOENEILITE; il

-

B

o

S

4 :

N 2
&

B o
~ ¥
=o@=zw « i 5

Page 1 Sec 1 1/1 At2.5cm Ln1 Col4 Tami =% ]

Lookup “active word” in MS Word. Note that the active word is not highlighted in MS
Word, but the word currently being composed is considered active.

To lookup active word, there should not be any error correction done when the word is
typed. For example, if the backspace key is used, the words “active” status is lost.

Lookup pre-typed word

To lookup a pre-typed word in a document, just select the word and press the Esc key.
This will bring up the look-up window in the same way as looking up “active word”. This
feature may not work in all applications. It has been tested to work in MS Word running
on Windows Xp.

Limitations of the lookup word feature

This feature is designed for quick lookups of words and not as a full-fledged stand-alone
dictionary. It is highly recommended that you close the lookup window by pressing the
“Esc” key again the moment you are done. Selecting a word or clicking on “Close” will
also close the lookup window.

Note: It is not advisable to keep the lookup window open and move to other applications.
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Murasu Anjal Fonts

Murasu Anjal 10 includes 25 Tamil typefaces that are completely Unicode compliant.
These typefaces are available on both Windows and Mac OS X platforms. This enables
users to easily take their documents and work across both these platforms.

Two of the typefaces include regular and bold variants. This feature allows a single
typeface with two different weights for consistent type styles in documents.

The table below lists some font faces that are available in Anjal 10 and their
recommended usage. This is just a sample set of fonts. There are more fonts in the
package that what is shown in the samples below.

Schoolbook Font : Recommended font for teaching and learning

Anjal InaiMathi has a variant that is specifically designed for primary school text usage.
The glyphs in this font, called Anjal InaiMathi Schoolbook, are designed to meet the
standard for letter shapes set by the Ministry of Education.

ST, WS, (W&, @emev, Ufley, UM, QLD

Body Text Fonts

The screen capture below shows fonts that are specifically designed for body text. Two
of these, Anjal InaiMathi and Anjal Chittu Slant, are available in two faces: regular and
bold. The emboldening of the stem widths of these fonts in design, make the bold faces
stand out from their regular counterparts. The effect will be much better than the
default emboldening done by Windows.
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Lyyedledr @ mind

LU [ GLlg WITENET. LLLeSE HDLOT WITEn60T
@ MUY aummdl ubST. LU LSS
SNBSS 3G OIS Sewlibg LTISSS!

Anjal InaiMathi
Regular & bold

yyeier Ggmind

LU (0 GLIg WTEGHT. LLL@JHEG LD
WITened & OB UTEIS uBSEI. L
ADFF YL BSH. A O\FTLbemw
Sienlbgl UTTSSS!.

Anjal Chittu
Slant
Regular & Bold

eder Ogmind

B RO GG WTEET. | yLe|&E SADoT
wrener @ Oamid eumhd absg. Ly
épFd JeoLpog. g Dsmiifeow Sewibg
LTI 58 -

Anjal Arulmathi

L allesr Qi

L R0 G- WTEHET. LLLIeYSEG ALOLDT WITENHES G(h
QmiLl eurmsid) aubHgl. L LIDFF yewL_ b5l
25 QFmileow yewflbg LIMTTSSS).

Anjal Mullai

pedlesr Qi

LLL| 6R(H GL_IQ WITEDEOT. LpLI6|&H(E DD WIT6w60T
Qm OsTUIL umnid aubsEl. 1L IDSIPFH
SIOLBSFH. 2H OFSTULemW Sellbg LIMTSHSHE.

Anjal Mallikai

L asor G\gmng

L 52 @LIQ WTED6OT. LLLINFHE) DT WTeD6sT
R QBTG sourkIsS) ubBHIHI. L 0SNPFS

AL BHSHFH. AFH CBTINTsmwr 4s55f1H )
uTj$S31.

Anjal Munivar
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Stylish Text Fonts
The screen capture below shows stylish fonts that can be used for casual body text or
sub headings:

,&(@ 57(0/@5 ﬂ@/f Anjal Amma
siBlp Clomp «flipn Anjal Selvam
QUS@ QLD’T@ Gﬁ’)_.Qﬂ' Anjal Sudar

Heading Fonts

The screen capture below shows some heading fonts that can be used in formal and
informal documents. The font Anjal Thoegai has another variant called Anjal Thoegai
College (not shown in the capture).

g}'ﬁ@ Q'_D"'@ 6)_“@“' Anjal Kayal
@“S’!..Q Qmﬂ_@ 6]?!_9{[ AnJ:aI IVTathavi
QI,B!.D 6]“)“'!5 Gﬁ!p“- Anjal Sinthu

@lﬂﬂ) GII.DIT !__ﬂ Qﬂu)]]‘ Anjal Thoegai
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Fonts and Styles
Murasu Anjal fonts can be used in any document that supports Unicode text. They can be
selected and applied in the same way as English or other language fonts.

For better type style management in a document, especially to maintain consistency, it
may be better to define the styles before hand.

Microsoft Word has predefined styles for Latin text. These predefined styles will pick
the default Tamil font in the system when they are applied to Tamil text. This may not be
desirable.

Murasu Anjal includes a Word template that has styles defined based on Anjal fonts. The
template, called AnjalTamil.dot, is saved in the installation folder (typically C:\Program
Files\Murasu Systems\Anjal10\AnjalTamil.dot)

When you open this template, AnjalTamil.dot, you will see the following styles added:

[E=EEoR[~%=] New Style @
S > X
hittu Slant v 16 v I U|®¥. Properties :
5 E Name: STETESNL WS
i = i Styles and Formatting v x -
@S| A Style type: Paragraph El
Formatting of selected text Style based on: q seme0liy 1 B
ooty 1 .
3 H Style for folowing paragraph: 1 SRS [~
[[selectal | [New Styte... | Formatting
=/ Pick formatting to apply " ey -
Anjal Thoegai B 16 EI . I
Clear Formatting = [ — = os
(Complex) Latha = = = = = D — 1l U =
Heading 1 1
Sample Text Sample Text Sample Text
Heading 2 1 Sample Text Sample Text Sample Text
. Sample Text Sample Text Sample Text
Heading 3 A Sample Text Sample Text Sample Text
Normal 0 Sample Text Sample Text Sample Text
- . Sa le Taxt Samnle Text Samnla Text
SemeuLiLy 1 1 S6M600IL 1 +Font: (Asian) Anjal Thoegai, (Default) Anjal Thoegai,
gmwﬂq 2 1 Complex Script Font: Anjal Thoegai, Left-to-right
Seneviiy 3 1 )
) Add to template Automatically update
g 1 i T
= | Format ~ ‘ I Cancel ‘
Styles Panel Dialog box to define your own style

Defining your own styles
Similar to Anjal’s styles, you can define your own styles in Word.

Click on the New Style button on the styles panel (picture above).
Give your style a name

Select the font desired

Ensure that the font is applied to all scripts

W N e

You will then see the style in the panel.
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Setting Anjal InaiMathi Schoolbook as the default Font
You can setup Word to use a default font of your choice. The following steps
show how you can make Anjal InaiMathi Schoolbook as the default font in Word:

1. Open Word and select the Fonts menu item (Format -> Fonts)

2 Do 0 d
P Fle Edt View Inserio-Ffimat | Tooks  Table Win
= = | A Fort...

é Normal > Times | =1

: Final Showing Markup~ + Sf *

Bullets and Numbering. ..

—M Borders and Shading...
i@—ﬂ_ Columns...
G

Tabs...
Drop Cap...
Text Direction...

Change Case...

Background
4| Theme...
Frames
AutoFormat...
Styles and Formatting. ..
Shift+F1

) Reveal Formatting...

Obiect...

2. Select Anjal InaiMathi Schoolbook as the font in the Complex Scripts
section and click on the “Default” button

Font ‘ Character Spacing | Text Efects |

Latin text fant: Font style: Size:
Times New Roman v
L]
|
Size
v [12 v
Font colo: Underline style:
Automatic v | | (none) v
Effects
[ Strike:hrough [[] shadow ] Smallcaps
[] Doubls strikethrough [Joutline [ all caps
[ Superscript [[JEmboss [ Hidden
[ subsaipt [JEngrave
Preview
L Sample o wr il i
This is a TrueType font. This font will be used on both printer and screen.

3. When prompted to make this the default, click Yes

Microsoft Office Word

2 Do you want to change the default font to (Default) Times New Roman, Anjal InaiMathi Sch Book, 12 pt?

This change will affect all new documents based on the NORMAL template.

Murasu Anjal 10 User Guide Page 23 of 35



Listing Font Names in their Fonts

In some installations, Anjal font names may show up as blanks in the font’s menu in MS
Word. This is not normally the case and only appears in MS Word running on some
configurations of Windows Xp systems. An example of the problem is shown below:

I'ji Normal L EEEEE [+12 + B LU
v o8 - o0+ s | T Andalus

: : T AngsanaNew ‘:‘

T angsanalPC

Ey

COC U U

If you experience this problem, you can turn-off display of fonts names in their own
fonts.

Select Tools->Customize->Options to see the following dialog:

Customize -2 |@

| Toolpars | Commands | Options |
Personalized Menus and Toolbars
Show Standard and Formatting toolbars on two rows
] Always show full menus

V] show full menus after a short delay

[ Reset menu and toolbar usage data

Other
| Large icons
I [CliList font names in their font: I

V| Show ScreenTips on toolbars

[] show shortcut keys in ScreenTips

Menu animations: | (System default) B

[geyboard... ] [ Close

Uncheck the option “List font names in their font”. All font names, including Anjal font
names, will appear in the system font in MS Word’s menus.
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Converting legacy text in MS Office

Before the adoption of Unicode, particularly its general availability in computer
operating systems, users have been creating documents in many different encoding
formats, such as TSCII, TAB, TAM, Murasu-6 and others.

These documents may not be usable in modern and future operating systems, as

Unicode is becoming the standard for all writing systems of the world.

Murasu Anjal 10, however, is aware of the formats of most of these old documents and
includes features that convert them into Unicode.

There are two converters in Murasu Anjal 10.

1.

Anjal Converter: This is an embedded converter that is installed as an Add-In to

Microsoft Office.
File Converter: This converts TXT and HTML files. File converter will be covered

in the next section.

Anjal Converter
To convert a old document in MS Word, PowerPoint or Excel is very simple. Open the

document and click the “Anjal Converter” button that is install in the toolbar.

The picture below shows Anjal Converter in MS Word.

] writeupinTamilTLseminar08.doc - Microsoft Word
! File Edit View Inset Format Tools Table Window Help

NS ERSES0VE B9 O 8 ) F 83% i

E] 302 Mo t»__:1|-;-|-:<I-E-I-i-I'E-l<€>-I-7-I-E-I---I-'.C"l-.ul-‘.:-l-:E- -

o 0glonoz

R RS SR - R TCR RS R RERY SRRE RERT SURT SERP SR SRR SRR PR

[l
&
o)

Page 1

=l

Sec 1

Oo’/aAII 2008

ALYV %k, 0®A¢ aEDQO “o Ao AlLE.S.QID. ABO.UiE.
YACIAES LALEAT DO%ALL1L7%60%.12.30A0,2008 0..03A¢. «ALES..
l«.@QﬁE&)QN Emu&xpg BI04 °¢i’, Ao “Agti AyEE «y U5 byUs -
A Aj A £yA%16

boc g \ix SAGIAES. UEe SASAISI IQASEALY 2%Ax Yy
uﬁwﬁﬁ SAGUAE S ‘\;rE;AQj B« ALXS. pﬂ «Ao? 49

%i D p4o

|ECO‘—\C
p@A¢. AGSAEY)
OAEES %%l i ;J@AC

o=he)
oA %A i 4"01 iY4ED Che %Ag0. AICE Cée YAty lIsAdYde

YAg0, 2, 8A U Cea %4 0.A 7400, C 01, AL 0AELL AL SASEA;

%41iA0SAAL.. OB CA. [N W) 3] LGEE- L.
SBEO0 ACOOYEEA] A LIARY A A (LA 6%k At %0 15

ASEj Ay, <L\- 0.A00 SE0AEO A= 0, ZagACLL 0AG ¢ 548 iAg S

2oEAGA L AiGAZNG.AUSE 2,10 ASD i 4D AE. . £ EAGE0%D.

0048 A ASCOAAGAINYEA ALEIAL. el ALIOSE AUUS AdYacAd I

WYELME §aig. X

) Jl’;A;&QW’@aw ﬁwww,ﬁ&gﬂww,,ﬂw 748088,

A%00.C0.A 107D AASANOYA D, .. 5 AIESALY. .8 AAchl

&WM"\:\EQQ :\WUQWMEMQ £ BOAUES A0%i0 (40 AATS. Q.

0266016231,
aOO.kQEJDW
3/AAAS A . Amid
T
1/1 At 25cm Ln1l  Col1l English (U.K.

m

“« o g
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The text appears gibberish because the original font used in this document is not
available in the system. In addition, no other Unicode font will help render the text, as it
is not in Unicode.

To convert the entire document to Unicode, you just need to click the “Anjal Converter”
button once. The button is placed in Word’s toolbar (highlighted in the picture above).

Anjal converter will then convert the document, scanning every character in it. For this
reason, converting Word documents may take a longer time compared to PowerPoint or
simple Excel Workbooks because of the volume of characters in the document.

Once the conversion is done, Anjal Converter will

1. Save the converted document as a new file.

2. The new file name will be based on the original filename, with “Uni” pre-pended
to it. For example, if your original file name is SAMPLE.DOC, the new file in
Unicode will be named as UNI SAMPLE.DOC.

3. The original document will be left as it is with no changes made at all.

If there is already a file called SAMPLE.DOC (perhaps because of a previous conversion),
the new file will then be called UNI SAMPLE 1.DOC. The number will be incremented
every time conversion is done on the same document.

A dialog box will appear at the end of the conversion as below:

Murasu Anjal Converter for Office @

Murasu Anjal converted old format Tamil text te Unicode and saved your
document as 'Uni writeupinTamilTLseminar08.doc'.
The criginal document is left unchanged

Note that the dialog includes the new file name in the message.

The converted document will be in Unicode and the font will be set to Anjal InaiMathi by
default. The typeface variations such as bold, italics, underline and even Word Art
graphics will remain as they are with the text replaced in Unicode.
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5] Uni writeupinTamilTLseminar08.doc - Mi Word (=& ]=]

i File Edit View Insert Format Tools Table Window Help Type a question for help - X

NEE RS TE 4 B9 o8 405 - @l Converter [ g
% 2 N N A A I I R A L P R SN I Ol RS N B C RN R P L BTN O

[L]  SEMEREEEENE o2 r 3 ade i S a6 T B 10 I 12 k13 1 14 (ISNAEH AT

- LUEMENS BPE LGS UGS LIGEHSHTEN S80GwmA /
LesIud HHIITRG 2008

Uigd Qzm sz8 sierf sag 20 &b uds
AGluEmESTE SHPOUTY QuiduE SEHSSTHD:
& sdgrf srRdd poidug. Sderamsd SGHUOLTEHE:

FHPQLTH siTTpd DD — DeweTwi LT THUITSD

Apdsga s0500nd sppd Cobum(E Swdafd SETad
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grenas s sdarfams,
EED Sopbg CaTan_g war
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R Ry - IR R e R I RE R RY TR RS RN NN RN R YRR SRR SRR

wramafsdam SO 33 2l O=lz. FBIEz0 -
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Page 1 Sec 1 1/1 At 20.2cm Ln 33 Col 24 EC EXT OVR Tamil Ox

Picture shows Word document after conversion to Unicode. Note that the default
font is set to Anjal InaiMathi. You may replace the font used in the converted text
with any other Unicode compliant Tamil font.
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PowerPoint and Excel

Similar to Word, PowerPoint and Excel will include the Anjal Converter button in the
tool bar. Click on this button to convert every slide in PowerPoint presentations or

every Worksheet in Excel Workbooks.

Picture below shows examples:

3] Microsoft PowerPoint - [Assessment(Vani).ppt] [=31o8 )|
i3] File Edit View Inset Format Tools SideShow Window Help Typeaquestionforhelp |7
3= =[] a ) A A | ) A o) o Design i Newside Ji

i il -5 -B 7 us [E]= h
PNEEREGS R VE % DB S0 =

=3 )

- | @ [Anjal Converter|

gl ~njel Convert:

AT R,
( U dn60%, )

i «OagATi

eviigy] ~

oREBEROCOIa¢

eviigigniog

ougAiogsed
UGAIGS ¢

aouvdmnied evimgeios
evigigniog

S6EPEIOLYi+¢

i

Click to add notes

T
iov- [ ] Astoshepess \ N DO A G @l &-Z-A-===ad@fl

Slide 2 of 11 Sample presentation slides English (U.S.)

Original PPT document before conversion

i8] File Edit View Inset Format Tools SlideShow Window Help
-1 -|B zUs|[E]=

i Arial

= 28 s= i Pl AL AT

3] Microscft PowerPoint - [Uni Assessment(Vani).ppt] [olfe] ==

Type a question for help - x

A - | = Design - New Slide !

HRANE=A" RN EITE YA NN - A R R e N
LSS :

]

7
R’E = [Click to add notes
.

@7 «
Do [I5] Autoshapes- \ N DOl il dl & @& &-Z- A= aaf

Side 2 of 11 Sample presentation sides Engish (U.S.) =]

After conversion: Every slide in the presentation gets converted.
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@ Microsoft Excel - Wordlist.(a - ow)Tamil Paada Neol - Pr3 - Thamizaga Arasu Veliyeedu.xls
E_'] File Edit View Insert Format Tools Data Window Help Type
§ 5 |[Anjel Converter] [ ¢ TAB Janani -0 -|[B]z U IR
. * ifina¢eg*eLogic@00¢ - ii=ogd¢otiESE - I0goLi
{A|M|CIDIE\F H [ 1 [ J [ kK [ =
1
2 |in "-Iﬂ'z{ﬁ‘! £
3
4 |S/N | Word ('U’ §6=-€) Freguency [Remarks
5 Uigi 40
6 ut 3
7 U-i 7
8 4]0-6 4
9 5|Uac¢ 23
10 5|Uinzeg 13
1 7|Viag 1
12 Udug
13 Usoge=g
14| 10[Ui~ud¢
15 11|Ui=d¢
16 12|Ud¢d 7
17| 13|Ude¢-o 7
18 14|U==6
19 15[U-e
20| 16)U-i
21 17|Ud¢bii¢
22| 18|UseoT 5
23| 19|U¢°
24 0]Ua¢a
25 1|Ubego=6¢
26 2|Ud¢o®
27 3[00g’ 4
28 4[UbogA=¢ 4
29 5|U6-6 4
| 30| 26|Ugetn 4
31[_27|UsgdE 4 il
PO PN PO Py
W < » Mhaaafefeefufuuenfeeh fifo oo fow/ <«
Ready

Excel Workbook before conversion

5] Microsoft Excel - Uni Wordlist.(a - ow)Tamil Paada Nool - Pr 3 - Thamizaga Arasu Veliyeeduxls

] File Edit View Inset Format Tools Data Window Help Type

{15 | Anjal Converter B 7 Anjal InaiMathi -0 -[B]z U = @3 o 5 R %

A2 - A 5L0IDE0EMDLIRWE - SWEILUUTL B - SRETHTLD auGUY
AT B T e "o T e [ F T 6 [ H T 1 7

1

2 [5895Qsmpluws - sBpOLT_ETe - epsipmd |

3

4 |S/IN |Word (' aflms) Frequency |Remarks

5 40

6 33

7 27

8 24

9 23

10 13

1 12

12 9]

13 8

14 8

15 7

16 7

17 7

18 6

19 6

20 5

21 5

22 5

23 5

24 5

25 5

26 5

21 4 il
ErN—Y] = T

W« » mhafaafefeefufuufenh/eehfifo/ oo ow/ <
Ready

Excel Workbook after conversion. Every worksheet in the workbook gets converted
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File Converter

Legacy Tamil text, i.e. text in old encoding formats, is also widely used in HTML
documents and scripts that are saved as plain text files. These files do not carry
extensive formatting information that Word, PowerPoint or Office documents carry.

To convert these plain text documents, Murasu Anjal includes a File Converter tool. This
tool lets you convert many documents in one go.

Start the file converter by clicking on the desktop short cut.

J e W

-

Computers = Shortcut to = Converter
AnjallOFil= Files

g m m o5 Murasu Anjal File Converter

Recycle Binss PDEWWTriter Sitar

5 Drag and drop files on the
packer. NewiT ext \VoltlEiles image above to convert

Documentin:

No files to convert

(=)

Select all the files you want to convert, drag them and drop them on the purple arrow to

start the conversion process.

(===
» march-testing of TL software converter » v { 5 ' l Search L ‘
\ Print (@ Burn
Name B Date modified Type Size B

). audio_video 17/4/20092:52 AM  File Folder
)\ images 17/4/2009 252 M File Folder

£ akka.htm 10/4/2003240PM  HTML Document 7KB L
£ akkal.htm 16/4/200910:58 PM  HTML Document 7KB i
£ ari_pakimthu.htm 10/4/2003241PM  HTML Document 15KB
£ ari_pakimthu2.htm 10/4/2003241PM  HTML Document 14KB
£ ari_pakimthu3.htm 10/4/2003241PM  HTML Document 13K8
£ ari_pakimthud.htm 10/4/2003241PM  HTML Document 19KB
£ ari_payanam.htm 10/4/2003242PM  HTML Document 10KB
£ cul festhtm 10/4/2003242PM  HTML Document 10KB
£ cul_param.htm 10/4/2003243PM  HTML Document
£]fun_gemehim 10/4/2003243PM  HTML Document Drag & Drop
£ fun_jokes.htm 10/4/2003243PM  HTML Document R e
& fun_un_ansl.htm 10/4/2003 2:43 PM HTML Document )
£ fun_un_ans2.htm 10/4/2003 244 PM HTML Document files here!
£ fun_un_ans3.htm 10/4/2003244 PM HTML Document
£ fun_un_ansd.htm 10/4/2003244 PM HTML Document
£ fun_un_ansS.htm 10/4/2003244 PM HTML Document
£ fun_unnal.htm 10/4/2003245PM  HTML Document 11KB

£ fun_unnal2.htm 10/4/2003 245PM  HTML Document 38 KB
9/4/200312:41 PM  HTML Document 2KB :

85! Murasu Anjal File Converter

Drag and drop files on the
image above to convert

No files to convert

File converter will sequentially convert the dropped documents to Unicode. In the case
of HTML documents, it'll look for <font> tags as well and change fonts of known format

to “InaiMathi”.
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As with Anjal Converter in Office, the File converter will also save the converted files
with a different name (with a “Uni_" prefix).

5! Murasu Anjal File Converter =
-
akka.htm Uni a .htm Converted from TSCII
akka1.htm Uni akkail.htm Converted from TSCII

ari_pakirnthu.htm Uni = Converted from TSCII

ari_pakirnthu2.htm Uni = Converted from TSCII

ari_pakirnthu3.htm Uni = Converted from TSCII

ari_pakirnthu4.htm Uni = Converted from TSCII

m

Drag and drop files on the
image above to convert

ari_payanam.htm Converted from TSCII

cul_fest.htm Converted from TSCII
cul_param.htm Converted from TSCII
fun_game.htm Converted from TSCII
fun_jokes.htm Converted from TSCII
fun_un_ans1.htm Converted from TSCII
fun_un_ans2.htm Converted from TSCII
fun_un_ans3.htm Converted from TSCII
fun_un_ans4.htm Converted from TSCII

fun_un_ansS.htm Converted from TSCII

fun_unnal.htm Converted from TSCII Y%

Picture above shows the results of the conversion process. Note that details of each file
are listed: its original name, the converted filename and the source encoding in the
comments column.

The converted files are presented as links. You can just click on those links to open the
files.

[t's important to note that the converter attempts to ‘detect’ the encoding based on some
predefined, internal rules. When the volume of text in the document is low, or if the text
is in some unknown archaic encoding, the results can be unpredictable.

Texts that are in TSCII, TAB and Anjal stand a better chance of accurate detection.

Important note on using converters

Both the Anjal Converter and File Converter included in Anjal is to help you convert
legacy documents to Unicode.

It is not designed to be a permanent tool that allows documents to be created in old
formats.

Technology changes and newer standards in document formatting may introduce
features that the converters may not understand.

For this reason, it is best for you to convert all your old documents to Unicode as quickly
as possible and discontinue using old formats. Create all your new documents directly
in Unicode to stay with changing times.

Important note: The converter can only convert from what is available in the original
document. It will not fix errors. In areas where it cannot convert a region of text,
particularly in PowerPoint documents, the converter will include a note in the slide with
suggestions on how the text can get converted manually.
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Anjal PDF Writer

PDF, abbreviation for Portable Document Format, allows you to distribute your
documents with the same formatting, as it would appear in print. This allows your
recipients to view your documents without having to install the application you used to
create the document. PDF also makes it possible to distribute your document as “read-
only”.

Anjal PDF Writer is installed as a virtual printer in your system. This allows you to
create PDF documents from any application that supports printing. All you need to do is
to print the document to Anjal PDF Writer and give your document a filename.

Creating PDF files

To use your PDF Writer, open the file that you would like to print to PDF. Select the Print
option (usually found under File > Print), and select "Anjal PDF Writer" from the list of
available printers. You will be prompted to select the destination directory and filename
for your output file.

= Print @

General

%‘HP Laser)et 1200 Series
i Microsoft Office Docun
RS Docume

= Anjal PDF Writer

= Fax

s HP Color LaserJet 8500 PS
< m

Print to file ‘ Preferences ‘

‘ Find Printer... ‘

Print H Cancel H Apply ‘

Please note that some applications, such as NotePad, will automatically print to your
default printer when you select the Print option. If you want to print to PDF Writer, you
may need to change your printer selection within that application before printing the file.
This can typically be done from Page Setup.
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Anjal.Net : Murasu Anjal Community Portal

Anjal.Net (http://anjal.net) is a community Web portal for Murasu Anjal worldwide.

The Website hosts articles, discussion forums, blogs and other content that are
published or updated from time to time.

This will be a great place for you to learn how to use the various features of Anjal and
apply them in your work. You may exchange ideas with other users from around the
world or even create your own forum to discuss ideas specific to the work you do.

The Website will also carry information on updates and upgrades to Murasu Anjal
software.

Registration is required to access the forums and it’s free. You may register at the portal
and create your own login account.

The Website is optimized for the following browsers:

Internet Explorer 7.0 or later
Firefox 3.0 or later

Opera browser

Safari 3.0 or later

B W=
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Uninstalling and Deactivating Anjal

Uninstalling Anjal
To un-install Anjal or Anjal PDF Writer, use the standard Windows uninstall feature.

1. Open Control Panel -> Add/Remove Programs
2. Double click on Murasu Anjal 10

This will remove Anjal from your system.

To uninstall Anjal PDF writer, open Control Panel -> Add/Remove Programs and select
Anjal PDF Writer.

Deactivating Anjal

If you do not want to uninstall Anjal but just de-activate it, you can do so in the regional
languages settings.

Open the settings window using the pull down menu in the language bar. Select Murasu
Anjal and click the “Remove” button. This will deactivate Anjal text service but will not
uninstall it from the system.

EN English (United States) Kl -
v @ Help

Settings...

Restore Defaults

Use the pull-down menu in the language bar and select “Settings” to invoke the Text
Services settings.

Text Services and Input Languages @@
Settings | Advanced

Default input language

Select one of the installed input languages to use when you start your
computer.

English (United States) - US v

Installed services

Select the services that you want for each input language shown in the
list. Use the Add and Remove buttons to modify this list.

[l English (United States)

&3 Keyboard
- US
mTamll
ey —
CI Vi Anjal
U
Preferences
[ Language Bar... ] [ Key Settings... ]

Select Murasu Anjal and click Remove to deactivate Anjal from the language bar.
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Re-activating Anjal
To restore Anjal text service, click on the Add button, select Tamil as the input language
and pick Murasu Anjal from the list of keyboards and input methods.

Text Services and Input Languages @@

Settings | Advanced |

Add Input language

Input language:
v

Keyboard layout/IME:

‘ Murasu Anjal v ‘

—=TEeeaT
TS

Preferences

Language Bar... Key Settings

ox ) Coms ] o
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